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 Using the template 
 

Overview 

 

These instructions cover using the MS Word 

template from this website. In this chapter you will be 

getting your book into the preformatted Microsoft 

Word template, which must meet the requirements 

Lulu has to print your book. This is critical because not 

only does Lulu have specific requirements but so do all 

of the companies in between Lulu, up to and including 

Amazon itself.  

 

Now if you have a very lengthy book and are a 

very experienced MS Word user and you have already 

formatted components such as the: headers, footers, 

chapters, sections etc then I have provided a checklist 

as a guide to the formatting in your existing book.  

 

__ If you want to test your book right now without put-

ting it into the template then go to Checklist Step 1.8 

now. If you get errors then please come back here and 

continue with the step by step process. 
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___Checklist Step 1.0 
 

 Before you start there is only one issue which 

you must address right now. That issue is does the mas-

ter template have enough chapters for the book you 

have written? If this template has enough chapters al-

ready preformatted inside then you can skip onto the 

next Checklist Step. Congratulations, you just saved 

yourself some work. If it does not have enough chap-

ters then the first thing you must do is to add chapters 

till it does have enough chapters for your book. 

 

__ Open the master template and compare it to your 

book. Are there enough chapters for your book? The 

Master template has 18 chapters built into it already. 

 

__ If the master template has enough chapters then 

jump to the next Checklist Step. If the master template 

does not have enough chapters in it then proceed with 

the remainder of this checklist. Adding pages and chap-

ters is a very delicate operation because it involves 

fixing the page title associations that you will break 

once you add in the new chapters. You must first de-

termine what kind of chapter you would like to add to 

your book. There are two potential chapter types you 

could seek to add to the book. The standard chapter is 

what I term the first type of chapter. This exists in the 

master template in chapters 1-18 along with the spe-

cialty named chapters: appendix, bibliography and 

index. The second type is one formatted very differ-

ently. It is much easier to add and those are the 

unnumbered pages at the end of the template. Let’s 

start by adding the standard type of chapters first. 
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 Before you go to all that extra work just one 

more question? Do you need all the extra chapters that 

are already in the master template? If for example you 

are going to have an Index but no bibliography or ap-

pendices, then you should first go into the template and 

rename those sections in order to avoid doing the extra 

work. If you don’t need to add chapters but simply re-

name them then proceed to Checklist Step 1.1. If 

changing the titles of the chapter names after chapter 

18 in the master template is not going to fit your book 

then skip the next Checklist Step and move to Check-

list Step 1.2.  

 

___Checklist Step 1.1: Renaming template headers. 

   

 If you are here it is because your book will fit 

into the template and only requires the renaming of the 

chapters continue using this checklist step. You will 

begin to reformat the master template and put in the in-

formation required into the headers. The headers are at 

the top of every page and have the chapter names on 

the one side of the book and the title on the facing 

pages of your book. 

 

__ Click on the big backwards P on your toolbar. When 

you hover the pointer over it you will see it say 

show/hide. After you click it you will see the format-

ting of your book. 

 

__ Starting with the first page in your Chapter 19, dou-

ble click on the header at the top of the page. If you 

like the amount of inserts in the template you don’t 
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have to change anything. If you would prefer to start 

your chapters closer to the top of the page delete the 

extra lines, one at a time till you like the look of the 

beginning of the chapter. Publishers recommend that 

you start your chapters in the middle of the page so that 

the text does not look crowded. On Lulu’s website 

there are recommendations for word and character 

counts per page. I recommend that you review them. 

They are located on the book formatting FAQs page. 

You will notice that any spacing changes you may have 

made are now the same for the last five chapters of 

your book. 

 

__ Starting with Chapter 19 change the name and num-

ber of the chapter.  

 

__ Repeat till you have renamed all of the remaining 

chapters in the template. Record the numbers below to 

make sure that you have done this step. 

__ __ __ __. 

 

__ Starting with your Chapter 19 go into the master 

template and find the first page where you have the 

first page that has the label Appendix A Title on the 

header at the top of the page. This step is not referring 

to the chapter title at the beginning of the chapters. An 

example of a title header page in the master template is 

page number 55. It is labeled CHAPTER EIGHTEEN 

TITLE at the top of the page. Double click the header 

and rename it to your chapter 19 title. You can also 

change the header spacing at this time if you want more 

or less lines in the header box.  
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__ Continue this process for your books Chapters 20 -

23 of your book (or whatever you have titled them in 

your book. Mark them completed in the space below.  

__ __ __ __.  

 

 Now if your book will now fit into the template 

move to Checklist Step 1.3. Congratulations you saved 

yourself some work by retitling the master template. If 

your book does not fit into the master template yet then 

proceed to the immediate next Checklist Step 1.2. 

 

__Checklist Step 1.2 Adding chapters to the master 

template. If your book requires more chapters than is 

already in the master template continue on with this 

checklist.  

 

__ Go to the last chapter of the master template. That 

would be your chapter 18. Hit the backwards capital P 

on your toolbar to see the formatting for the book. 

 

__ Highlight the entire last chapter starting from the ti-

tle going all the way to the end of the chapter which 

closes with the words “section break new page.” 

 

__ Copy the chapter and then move to the end of the 

last line you just copied, labeled “section brake new 

page. Paste the copied chapter in at exactly that spot. 

 

You will need to break the title of the page 

header association with the previous chapters’ page 

header title. You must do this in order to get the newly 

pasted in chapter header to title correctly. When refer-

ring to title header; the reference is to the title header 
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which appears at the top of your chapters between the 

title page and the next chapters title page. This step is 

not referring to the chapter title at the beginning of the 

chapters. An example of a title header page in the mas-

ter template is page number 55. It is labeled CHAPTER 

EIGHTEEN TITLE at the top of the page.   

  

__ Since you copied chapter 18 in the last step, make 

sure you are on the second copy of chapter 18 before 

proceeding. Double click on the title of the page header 

in the chapter you just added. The formatting toolbar 

pops up. Move your pointer over each of the icons on 

the toolbar till you find the one that says “same as pre-

vious,” while hovering over that icon. Click that icon 

one time. You have just broken the association with the 

previous chapters’ page header. You did this by tog-

gling off the page header feature which will not allow 

you to change the name of this chapter header till you 

did this. If you did not change it, the previous page 

headers name would have changed to the same new 

name you just typed in. 

 

__ MS Word may pop up a dialog box requesting you 

to say yes or no to this action. Select yes. 

 

__ On that same title header change the chapter number 

to Chapter 19.  

 

__ You have two chapters which have identical titles 

(18) at the beginning. On the second copy of the chap-

ter go now and change the title page to 19. It will save 

you a fair amount of confusion by doing this now. 
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__ Double check that you have done this correctly. 

Check that you now have not a chapter beginning with 

19 now but also scroll down and check the title header 

says 19 as well. Scroll back to chapter 18 and check its 

title header as well. 

 

__ If it does not display what you have just done then 

close the master template without, and I repeat without, 

saving it and repeat the checklist step above.  

 

__ If the master template does display correctly the 

new chapter that you have added then continue looping 

on this checklist till you have added all the chapters to 

the master template that your book requires.  

 

__ If your master template now has enough chapters for 

your book skip the next checklist and jump to Check-

list Step . Congratulations your master template should 

now be ready to start moving your book into it.  

 

___Checklist Step 1.3 Adding your books chapters, 

headers and titles into the master template. 

 

__ Highlight all the text in your book for a single chap-

ter and copy it. You can hit Ctrl-C or go up to the Edit 

menu and select copy from the File menu, not cut. I 

prefer Ctrl-C as you don’t have to leave your high-

lighted text for the copy. You should now have nothing 

in chapter one from your book. 

  

__ Go to the template and click on the spot directly be-

low the chapter number that corresponds to the chapter 

you have copied and paste it into the template. You can 
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do this quickly by hitting the Ctrl-V key or again you 

can go to the Edit menu and select paste. 

 

__ Repeat this sequence of copying and pasting till all 

of your chapters are moved into the template. If you 

have an enormous chapter book and exceed the 18 pre-

formatted chapters in the template you can fix that. For 

now just stop after chapter 18 has been moved into the 

template. Don’t do anything yet as depending on the 

book you can retitle the extra sections in the template 

and that will give you an additional five chapters to 

work with. I will address how to create more chapters 

in the template a little later. If you have more than  23 

chapters you may want to consider reducing your chap-

ter totals to fit the template, as it is a fair amount of 

work, now that’s just a suggestion mind you.  

 

__ I am putting some space here so that you can record 

each chapter number after you have copied it. Better 

safe than sorry. Do not delete any extra pages yet, even 

if there are many more chapters in the template than in 

your book. 

 

__ Chapter numbers you have moved into the template: 

__ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ 

__ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __  

 

___Checklist Step 1.4: Filling in the basics. 

 

 The next thing you are going to do is starting 

from the very beginning of the template type the infor-

mation into the template. You can copy and paste but 

the formatting might get affected in the template. If 
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your dedication/acknowledgement section goes on for 

many pages then copying it will probably be easier. 

 

__ Title Page fill it in. You should use the information 

that you put together at the end of chapter one for this. 

 

__ Fill in future projected Publication date. Don’t for-

get it takes awhile even you are happy with your book 

to get to Amazon so I would add at least four months 

onto the current date for your books publication date. 

You don’t want the book look it is old before it even 

got to Amazon’s bookshelves for sale. Don’t worry 

about the ISBN number yet.  Leave ISBN field blank 

for now. 

 

__ Move your book’s Preface.  On Amazon they have a 

featured called Search Inside. It allows shoppers to read 

nine pages past the front cover of your book online. 

That’s nine pages from your very first page, not the 

numbered pages in your book. So you should aim to set 

the hook for your book in those first nine pages. That 

means your preface is a really big opportunity to get 

readers interested in your book. So make sure your 

preface gets your books mission and tone across. 

    

__ Acknowledgements/Dedication filled in. 

 

__ *Leave Contents page blank for right now. 

 

__ The last page must be blank. Leave at least one page 

 blank and two is ok as well. 

 

__ Move your appendix(s) into the template. 
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__ Move your Bibliography into the template. 

 

__ Move your Index into the template. 

 

If your book fit into the template then you have it 

all in the template now. If this is your case then move 

to the head of the class. Move onto Checklist Step at 

this time.  

 

___Checklist Step 1.5: Removing color images. 

If you are making a color book then you can 

check off this step and jump to next one. The reason is 

because if you have images already in your book then 

you need to understand that you may have to remove 

them and recopy them back into your text after you 

have converted them to black and white. 

__ Check your book and see if there are any images in 

your book that are in color.  

__ If so then open your image editing software and 

convert them to black and white. Then paste them back 

into the spot they were in your book. If you installed 

Paint.Net program and this is new to you then let’s 

walk through the process together. 

__ Click the Adjustments tab – top middle of program 

and then click black and white. After you have con-

verted your picture to black and white then look on the 

left side of the program for a toolbar labeled tools. In 

the upper left of that toolbar is a tool labeled rectangle 

select tool. Just put your pointer on top of the tools and 
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the labels will display themselves after a second. Click 

the rectangle tool and then put your pointer in the upper 

left corner of your picture. Hold down the left mouse 

button and drag the pointer all the way into the bottom 

right corner of your picture. Let go off the mouse but-

ton. Now the whole picture has been selected by the 

tool. Go to the Edit tab towards the upper right side of 

the program and click Edit and then Copy. Now it has 

been copied and is ready to be copied into your book. 

__ Repeat this process till of your images are now 

black and white and all pasted into your book.   

 If you don’t have any images in your book you 

still needed the program in order to create a custom 

book cover for your book later. You will cover that in a 

later chapter. 

 

___Checklist Step 1.6: Template headers & finishes. 

 

 

__ Fill out the Contents page with the books contents 

and page numbers. 

   

Now you will begin to reformat and put in in-

formation into the headers throughout the book. The 

headers are at the top of every page and have the chap-

ter names on the one side of the book and the title on 

the facing pages of your book. 

 

__ Click on the big backwards P on your toolbar. When 

you hover the pointer over it you will see it say 

show/hide. After you click it you will see the format-

ting of your book. 
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__ Starting with Chapter One double click on the 

header at the top of the page. If you like the amount of 

inserts in the template you don’t have to change any-

thing. If you would prefer to start your chapters closer 

to the top of the page delete the extra lines, one at a 

time till you like the look of the beginning of the chap-

ter. Publishers recommend that you start your chapters 

in the middle of the page so that the text does not look 

crowded. On Lulu’s website there are recommenda-

tions for word and character counts per page. I 

recommend that you review them. They are located on 

the book formatting FAQs page. You will notice that 

the change you made to the formatting for the header in 

Chapter one has now been made to all of the chapters 

in your book. 

 

__ Go to page two of your book. Double click on the 

header. I have inserted three lines for spacing. If you 

are good with that spacing then delete the placeholder 

title and type in the title of your book. Your title is now 

throughout the entire book as well. 

 

__ Go to page three of your book. Double click the 

header and type in the name of the first chapter of your 

book. That name is now in every header throughout the 

first chapter of your book. 

 

__ Repeat for every chapter of your book, Appendix(s), 

Bibliography, Index etc. I will put a place for you to 

record them below just as you did with the cutting and 

pasting of chapters. 
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__ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ 

__ __ __ __ __ . 

 

__ If you had some type of section in the unnumbered 

pages go to those headers and title those pages. 

 

In this step you will begin deleting all the extra 

pages before the end of the template. Not the blank ex-

tra last page or two but all the rest of the extra pages 

prior to the end of the template. Before you start delet-

ing the extra pages a word of warning. Be very careful. 

Highlight all the text on the page to be removed and 

then hit delete. Don’t just put your pointer at the top of 

the page and whack the delete button a bunch of times. 

You will end up deleting formatting and text that will 

cost you time to go back and repair. 

 

__ Very carefully now begin deleting the extra pages 

from the template.  

 

Now you have reached the point where your 

book is in the template with the exception of the ISBN 

number. The reason you left that out is because you 

will have to go back later in process where you will 

purchase the distribution package and they will gener-

ate an ISBN number they assign you. It will be covered 

in another checklist so don’t worry about that now. But 

you should now be looking at your complete book with 

the only exception of the ISBN number.  

 

__ Count the total pages of your book. Not just the 

pages which are numbered but the total pages, even 

blank pages. Note in the end your total book pages 
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must be divisible by four. In the template it lists the 

page you are on and the total number of pages in bot-

tom towards the left. If you are on page 24 of 40 page 

book then is looks like this: 24/40. 40 is your total page 

count at this point. Don’t worry about the fact that in 

the end your book must have a total page count divisi-

ble by four. If it is not divisible by four just add in the 

extra pages until it is. 

 

__ Double check all of your pages for your fonts, your  

footnotes and everywhere in between. Don’t forget, 

they must be one of the fonts in this list: Arial, Book 

Antigua, Bookman Old Style, Century, Courier, Gara-

mond, Palatino, Tahoma, Times New Roman, Verdana, 

Symbols. If not then your book will fail while upload-

ing causing pain and delay. 

 

__ Check any embedded images in your book. Make 

sure they are all set to grayscale instead of color. They 

can get muddy when they convert them for you. I have 

included some images at the end of this book so that 

you can see what black and white images will look like 

in your book when it is printed. 

 

__ Your name and title of your book should be in the 

properties section of your template now. You should go 

into it and put your name and information inside of it. 

Here’s how to do that: 

- Inside of MS Word click File (left corner) 

- Click properties. If you can’t see properties then 

click the double chevron to display hidden func-

tions. You will then see properties.  This works to 

unhide items for all MS Word headers. 
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- Click the general tab and delete my info and insert 

your own.  

- Save your changes. 

 

__ Print your book out on your printer. Perform the 

checks needed on the output to insure that it looks ex-

actly the way want it to appear when it is inside the 

covers of your new book. I am inserting a footnote here 

to remind you to look over your footnotes as well
1
. I 

won’t use anymore footnotes in the book. This one was 

purely a reminder to make sure that you checked yours 

in your book. 

 

If your book is now complete then congratula-

tions you have now created a book in your Microsoft 

Word template that is ready to be converted into the 

format that Lulu needs to print your book. You can pe-

ruse some of the MS Word formatting explanations that 

will follow in this chapter if you would to review some 

formatting tips or you can now simply move on to 

chapter three.  

 

For those of you who have books with a format-

ting problem or are printing a different sized book of 

some kind then please move on to the next checklist. 

 

___Checklist Step 1.7 Cleanup tasks. 

 

 If you have arrived at this checklist then you are 

here to clean up the loose ends or problems still re-

maining with your book. This section is not going to be 

                                                 
1
 Check all of your footnotes in your printed copy. Are the Fonts 

consistent and do they look easily readable? 



 17 

checklist driven. Select from the heading that you need 

to fix your book. Once you have found what you need 

in this checklist step then it is a good rule of thumb to 

go back through the previous checklists and make sure 

that any changes you made in formatting has been 

checked before continuing onto chapter three (creating 

covers for your book). 

  

Page Numbering: The page numbering should have 

remained continuous as well. If however you wanted 

unnumbered pages in your extra chapters then just copy 

the page labeled “unnumbered pages start here.” Then 

paste them following those pages in the template. 

 

Page Footers: Editing the footers on added pages and 

chapters. If you don’t like how the footers are centered 

in your book then copy one of the previous footers that 

you did like and paste it into the footer section of the 

chapter you are not happy with. Sometimes you will 

have to do this twice in order to get the first one to cen-

ter correctly so use patience when editing the footer 

formatting.  

 

MS Word properties: Configuring Settings for 6x9 

books. If you are using the template then you should 

now have your book into the template. If you did not 

use the template then the following settings for your 

book are recommended in order to get it set up properly 

for 6x9 printing. 

 

__ Go to the File tab at the top left of your screen. Se-

lect Page Setup from the drop down list. A box will 
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pop up titled Page setup. In the Margins tab make sure 

the following values are in your Page setup fields. 

 

__ Top, Inside, Outside and Bottom should be set to: 

0.7. The gutter should be set to 0.25. 

 

__ Paper orientation set to portrait. And the pages sec-

tion should be set to “Mirror Pages.” 

 

__ On the Paper tab it should be set to custom size and 

a width of 6” and a height of 9”. 

 

__ On the Layout tab you should have the section start 

set to “New Page”. In the headers and footers both of 

the different boxes should be checked on. The From 

Edge settings should be 0.5” for header and footer. 

 

 If you are trying to do something different than 

the template and this books instructions layout then I 

recommend you go online and speak to one of the sup-

port folks at Lulu if you still can’t get the book to look 

what you want it to look like.  

 

___Checklist Step 1.8 Testing your book. 

 

 You are now ready to print your book and see 

what the book looks like that you have created.  

 

__ Open your virtually completed book up in your MS 

Word program and click the File menu and select the 

Print option.  

 

__ In the top of the dialog box is a drop down box. In 



 19 

that box is the name of the printer where your docu-

ment will print if you select OK. Single click on the 

right side of that pull down box. 

 

__ Select the printer labeled CutePDF Writer. Then 

click the OK box at the bottom. This will invoke the 

CutePDF program. 

 

__ When the CutePDF program brings up its dialog 

box then you can save your converted book by clicking 

OK. Depending on the length of your book it will take 

a few moments to convert and save your book. The 

document your book has become is the same name as it 

was in MS Word but now has a .PDF extension instead 

of a .DOC extension on the end of it. 

 

__ If you chose not to use the template provided at my 

website and you had error messages when the CutePDF 

program converted your book from MS Word then you 

can do one of two things. You can either go into the 

previous Checklist Step and double check the configu-

ration instructions in that checklist or you need to start 

at the beginning of the book and copy your book into 

the template provided. If you don’t there is no predict-

ing what your book will look like if you upload it to 

Lulu with formatting errors in it. That’s even if it al-

lows you to upload the document at all.    

 

__ You can either double click on the PDF file you cre-

ated or you can open it from the Adobe Reader 

program. It doesn’t matter which way you choose to 

view your book in this format.  

 



 20 

__ First, scroll through your book on your monitor. 

You are checking for the formatting and the looks of 

your book. If there is something you don’t like then go 

back to your book in MS Word and repair it.  

 

__ If your book looks good on the monitor, then print it 

out on your printer. This time make sure that the printer 

connected to your PC is the printer selected when you 

print out your book.    

 

__ Review your entire book from the title page to the 

very last blank page. If you are happy with how it looks 

then you are now ready to move to chapter three and 

design the covers for your book. 

 

  

 

 
 



 

 

 

Creating Covers 
 

  

 In creating the covers for your book you have 

several different ways you can choose to design your 

cover. The first and simplest method is to select one of 

the covers designed by Lulu. If you select one of her 

covers and then essentially the only decision you must 

make is whether or not to have your name and title of 

the book on that cover. There is nothing you really 

have to do other than press a few buttons. The second 

way is to select one of Lulu’s designs from her gallery 

and then download and customize it to your liking. 

This will involve using the Paint.Net program but is 

still very simple to do with the checklist and instruc-

tions. The third way to go is to create the covers in the 

Paint. Net. Program and then upload them. A little 

more complicated but still a very manageable set of 

work items. The only thing you won’t be able to do 

with all three of these options is too design anything for 

the spine of the book. If your book is long enough Lulu 

will allow you to select the text and color for the spine 

but no custom images. If you really want a custom im-

age on the spine then you would be required to do what 

they call a one piece cover and that is complicated. It is 

complicated because there are many variables involved, 

including calculating the actual spine width of your fin-
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ished book. Upon determining those numbers you 

would then have to tackle making a cover with those 

numbers correctly factored in, that it is centered in all 

three sections of the book exterior. This book was writ-

ten for you to succeed in getting published and for sale 

onto Amazon therefore I am not going to introduce a 

topic where I am not 100% confident that I can check-

list it and that you could do it without having to 

struggle or fear that you can do it. 

 

 As you might have guessed then the chapter will 

divided into three sections addressing the three differ-

ent types of cover projects. I recommend you review all 

three sections. Let’s get started. 

 

___Checklist Step 2.0: Reviewing Lulu’s own cover 

designs.  

 

 The decision you must make here is predicated 

on whether or not you like Lulu’s cover designs. In or-

der to do this you must now to go to Lulu’s website and 

look over her covers.  

 

__ Go to Lulu’s website and scroll down the left hand 

side banner. Under Book FAQs there is a link to book 

cover FAQs. Click it. 

 

__ The first answer in the FAQ has a link labeled 

“View the gallery covers here”. Click it. A window will 

pop up after 15 or 20 seconds showing you all of 

Lulu’s cover designs. Once you have reviewed them 

you must make a decision as to whether or not you 

want to use one of them. If you do want to use one of 
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Lulu’s stock covers unmodified, then the only thing 

you need to know is how to determine Hex color values 

for your spine and rear cover. Therefore I do recom-

mend that you review the next checklist in order to see 

some other options available to you and how to deter-

mine matching colors for your books spine and rear 

cover. 

 

___Checklist Step 2.1: Modifying Lulu’s covers. 

     

 If you have found one of Lulu’s covers that you 

really think speaks to your book then let’s download it 

and talk about the issues surrounding using one of 

Lulu’s covers.  

 

__ To download a cover by Lulu, click on the link just 

below the image labeled “download this cover”. It will 

pop up in a window a few moments. 

 

__ Right click anywhere on the displayed image and 

another smaller dialogue box will pop up next to your 

pointer.  

 

__ Select copy image from the window. You have now 

copied the cover into the memory of your PC. It is not 

stored anywhere yet so don’t shut down your PC till 

you saved the image in memory. 

 

__ Open the Paint.Net program. 

 

__ Go to heading labeled view. Select it and then select 

Ruler. You will see a ruler across the top and the left 

side of your screen in the program.  
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__ Go back to that same heading and make sure the set-

ting is inches and not pixels. If the pixels entry is 

checked then click on the inches entry just above it to 

change what type of numbers the ruler will show you. 

You will need this to make decisions as to what is cen-

tered on your cover.  

 

__ On the headings at the top of the program select 

Edit.  

 

__ Then select Paste. Just paste, not any of the other 

option. Once you do this the cover will appear in the 

paint program. Now that you have the image in the 

program you can see that is much larger than what you 

need for a book cover.  How did I know this?  

 

__ Go to the menu heading at the top of the program 

and select “Image” and then select “Resize” from the 

menu. This will bring up the resolution and the size of 

the image you have selected. You can see both the pix-

els and the size in inches. The size you need for our 

cover is a width of 6.25” by a height of 9.25”. Before 

you change any of the settings however you need to in-

crease the resolution to 300 pixels per inch. 

 

__ Highlight the 96.00 number already in the resolution 

box and then type 300. 

 

__ In the Resampling box uncheck maintain aspect ra-

tion. If you didn’t do this then when you changed a 

dimension in the Print Size box the other dimension 

would automatically change to a size that you don’t 
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want. 

 

__ Now in the Print Size boxes go to the Width box. 

Highlight that number and type in 6.25. 

 

__ Now in the Print Size boxes go to the Height box. 

Highlight that number and type in 9.25.  

 

__ Click Ok and the image was resized for you. I rec-

ommend saving that image right now. 

 

__ Click on File and select Save As. When the window 

appears then you must give your cover image a name. 

 

__ I recommend saving the file as a PNG file for now 

but you could also save it as a JPG. Lulu will accept 

either format for your covers. I get nervous with JPG 

though because it does compression on your image and 

I don’t know if that could affect the image quality. 

With that your image is now saved onto your PC.  

 

 With this paint program you can do many things 

to that image. You could draw on it. You could paste 

other images onto it and of course you can title the im-

age anything that strikes your fancy. Just remember 

that this image is a quarter of inch (0.25”) to big for 

your book. It will be trimmed down when it is printed 

so make sure that you don’t get close to the edge of the 

image when you are laying it out for use in your book. 

The second issue that I want you to understand is re-

garding cover colors. Not the marketing issues but the 

technical issues. I have read that due to the technology 

of POD printing that sometimes when darker covers are 
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selected that you can get a light line where the spine 

meets the front and back covers. In order to see how 

bad this issue really is I am going to violate the market-

ing advice that I have read about and select a dark blue 

color for the entire outside of the book. You will both 

know when the book is published if that is a factor in 

publishing future books. So I didn’t go for the nicest 

looking book cover but the most dangerous one from a 

POD printing technology perspective.  

 

 Let’s go over some instructions on how to mod-

ify your cover that you saved in the previous step. If 

you would like to type some words on your cover do 

the following. 

 

__ In the lower left is a box which allows you to pick 

colors. In the upper right side that is a box labeled 

“more”. Click on it now. You now see more informa-

tion about any color you will select.  

 

__ Click on color in the big round circle or from the 

box beneath that circle in order to select a color for 

your words that you are going to type on your cover. 

 

__ Click on the symbol that looks like a capital A on 

the left hand side toolbar labeled “Tools”. It is about 

two thirds of the way down in that toolbar. 

 

__ There is a box labeled “Font” above the image. Se-

lect the font you would like to type in. 

 

__ To the right of the Font box is a number box. You 

can select up to 72 from the box by scrolling down the 
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right side of it. What I want you to do is now type 140 

into that box. This way you will be able to see what 

you are typing. 

 

__ Move your pointer to the middle of the image and 

type testing 123. You can now see that text on the im-

age. A few notes for manipulating your text in this 

program. When you move your pointer over the symbol 

that looks like a cross, your pointer turns into a hand. 

When your pointer is a hand you can drag your text 

anywhere on that image. If you look on the right side of 

the screen you will see a box labeled “History”. At the 

bottom of the box is where you can undue what you 

have just typed. This is very handy for quickly making 

corrections when you make mistakes.    

 

Hex Color Values: 

Pay particular attention to the box on the middle right 

labeled Hex. When you click on a color either in the 

big round circle or from the box beneath that circle, the 

color you selected will produce a specific Hex code as 

to what that color is. It is displayed in the Colors box 

whenever you have selected a color. You don’t need to 

know what the hex code is for the letters you typed but 

you will have to know what colors blend well for your 

spine and your rear cover. That is because Lulu re-

quires that input the hex value for what colors you want 

on your covers. The other method they give is to select 

from a few colors in a box from her website but it 

really is limited. Don’t use that method. Instead use the 

method where you tell her what hex values you want. 

To show you how to determine the colors that match 

your cover and their values let’s do the following. 
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__ Select the Paintbrush symbol for the Tools toolbar.  

 

__ After you have selected the paintbrush you need to 

increase the brushes size you need in order to see it on 

the cover. Go to the Brush Width box above the image 

and select 100. That’s really big, you should see this 

color very easily now. 

 

__ Go to the colors box and select a color you think 

might look good for the spine of your book. 

 

__ After having selected the color now go to the left 

side of your image and you will see the pointer turn 

into a bulls eye. While holding down the left mouse 

button drag the line all the way down your image. You 

should see very clearly now if you have found a good 

complimentary color for your book. If you hate the 

color go back to the History box and select the undue 

button and then continue choosing other colors till you 

have found that you want for your spine. Once you 

have found that color then write that number down! In 

fact I would copy it from the Color box and paste it 

into your book, labeling what that number means. I re-

commend that you should now paste that hex color 

value onto the copyright page somewhere. I will in-

clude a step later to make sure you have removed that 

from your book before it goes for publication (Check-

list Step). Once you have found the perfect color you 

need for your books cover, you really don’t want to 

loose it. 

 

___Checklist Step 2.2: Custom Cover 
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 The reason I had you look at how to manipulate 

Lulu’s cover was so that you didn’t have to explain the 

same material twice in this section as well. You can go 

straight into making a totally custom image rather sim-

ply and quickly now.  

 

__ Open up your paint program and select File and 

New. In the dialog box that popped up make sure that 

you change the resolution to 300 and input the values 

of 9.25” for height and 6.25” for width.  

 

__ You are now looking at a blank canvas so to speak. 

If you want a color field then select the color you want 

the color field to be from the Colors box. 

 

__ Then select the paint bucket from the Tools toolbar 

and move your pointer into the image somewhere.  

 

__ Left click the mouse button and you should see your 

image get completely repainted the color that you 

chose for it. 

 

 You can do other things too. You have reviewed 

these possibilities in the previous checklist so no need 

to repeat them here. There are some other possibilities 

that I didn’t mention though. You can do things like 

open pictures up into the paint program and copy all or 

part of them onto your covers. To copy or all or part of 

another image into your cover image do the following 

steps. 

 

__ Go to your tools toolbar and select the Rectangle 
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tool in the left hand corner. Move your pointer into an 

image that you want to copy. 

 

__ Holding down the left mouse button highlight the 

areas of the picture you would like to copy. Release 

when you have the portion of the picture you would 

like to copy.  

 

__ Go to the Edit menu and select copy.  

 

__ Open up the cover image you want to paste the de-

tail into. 

 

__ Go back to the Edit menu and select paste. You can 

then move the image around your cover wherever you 

would like it to be by holding down the left mouse but-

ton while you move the detail around.   

 

 You can see just how easily you can get very 

creative for covers that are custom or by modifying 

Lulu’s own cover designs. Since you will need to spend 

some time here I recommend that you do. I also rec-

ommend that you play with the power of the image 

editing program. I won’t detail the functions but it is 

quite powerful and can do anything that you can think 

of to an image for you. So explore it so that you are 

comfortable with it when you really get serious in pro-

ducing your covers. In the next chapter you will take 

everything you have created and upload these files to 

Lulu. I hope you are as excited as I am at this point as 

you are not very far from ordering your proof copy of 

your book!



 

 

 


